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Adobe Creative Suite 5 Design 
Premium combines:
•	�Adobe Photoshop® CS5 Extended

•	�Adobe Illustrator® CS5

•	�Adobe InDesign® CS5

•	�Adobe Flash® Catalyst CS5

•	�Adobe Flash Professional CS5

•	�Adobe Dreamweaver® CS5

•	�Adobe Fireworks® CS5

•	Adobe Acrobat® 9 Pro

Additional components:

•	Adobe Bridge CS5

•	Adobe Device Central CS5

Integrates with new	
Adobe CS Live online services*

Discover powerful new creative tools for expressing your ideas and crafting artwork that 
stands out. Finish your work faster, with numerous enhancements to the tools you use 
every day. Extend the reach of your designs to new media without writing code. Streamline 
creative reviews and other essential but time-consuming tasks.

As a designer, your job is to create content with impact—content that attracts, informs, inspires, and 
persuades. Often, this means coming up with solutions that no one has ever seen before—including you. 
With Design Premium, you can translate even your outrageous ideas into reality, moving smoothly and 
efficiently across multiple media.

Take advantage of Flash Catalyst CS5 to design interactive content without ever writing a line of code. 
Bring page layouts to life by adding sound and motion in InDesign. Create expressive artwork with 
groundbreaking painting tools in Photoshop Extended and Illustrator. Polish off routine tasks more 
quickly, from masking images in Photoshop Extended to finessing strokes in Illustrator to fine-tuning 
layouts in InDesign.

Adobe Creative Suite 5 Design Premium software combines Adobe Photoshop CS5 Extended, Illustrator 
CS5, InDesign CS5, Flash Catalyst CS5, Flash Professional CS5, Dreamweaver CS5, Fireworks CS5, and 
Acrobat 9 Pro as well as Adobe Bridge CS5, Device Central CS5, and integration with new Adobe CS Live 
online services*.

Adobe® Creative Suite® 5 Design Premium
Deliver innovative ideas in print, web, interactive, and mobile design

* CSLive online services are complimentary 
for a limited time. See the last page for 
details and limitations related to all Adobe 
online services.

Brand new in CS5 Design Premium, Flash Catalyst CS5 equips you to design interactive content using intuitive tools that leverage 
skills you already have—and without writing code.
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Top new benefits

Explore new creative realms
•	Realistic painting effects in 

Photoshop CS5 Extended (Page 2)

•	Fluid vector painting in Illustrator 
CS5 (Page 4)

•	Easy 3D extrusions with Adobe 
Repoussé in Photoshop CS5 
Extended (Page 5)

Express your ideas faster
•	Truer Edge selection technology in 

Photoshop CS5 Extended (Page 6)

•	Beautiful strokes in Illustrator CS5 
(Page 7)

•	Simplified object selection and 
editing in InDesign (Page 8)

•	Multiple page sizes in a single 
InDesign document (Page 9)

•	More efficient CSS-based design in 
Dreamweaver CS5 (Page 10)

Extend the reach of your designs to 
new media without writing code
•	Interactive content design in	

Flash Catalyst CS5 (Page 11)

•	Dynamic digital documents in 
InDesign CS5 (Page 12)

•	Superior text layout and typography 
in Flash Professional CS5 (Page 13)

•	Simplified mobile content design in 
Fireworks CS5 and Device Central CS5 
(Page 14)

Maximize your design time by 
streamlining critical non-design tasks
•	Accelerate reviews through 

integration with Adobe CS Review 
(Page 14)

•	Web-page preview with Adobe 
BrowserLab, a CS Live online 
service* (Page 15)

With Adobe Creative Suite 5 Design Premium, you can:

Explore new creative realms. Break fresh creative ground with innovative tools. Achieve beautiful 
painterly effects using lifelike brush strokes in Photoshop Extended and expressive vector-painting 
brushes in Illustrator. Use 3D extrusion tools in Photoshop Extended to create eye-catching 
artwork for print layouts, animations, or immersive environments. 

Express your ideas faster. Turn your ideas into reality more quickly and intuitively than ever 
before. Work faster and more efficiently using more precise image-selection tools in Photoshop 
Extended, variable-width strokes in Illustrator, and intuitive object-selection features in InDesign.

Extend the reach of your designs to new media without writing code. Deliver your work onscreen 
to connect with more people in more ways. Use new Flash Catalyst CS5 to transform Photoshop and 
Illustrator artwork into high-quality interactive content and navigation elements for web pages and 
user interfaces without writing code. Or use InDesign to easily add impact to page layouts and 
presentations by incorporating hyperlinks, buttons, page transitions, video, and sound. Publish book 
layouts in eBook reading format with high fidelity to your original design.

Maximize your design time by streamlining critical non-design tasks. Accelerate essential
but time-consuming tasks such as creative reviews with new Adobe CS Live online services*, 
which integrate with components of Design Premium. Use Adobe CS Review to initiate an 
immediate online shared review from within Photoshop Extended, Illustrator, or InDesign. Hold a 
meeting online and share your screen by accessing ConnectNow, a web conferencing service in 
Acrobat.com, with a single click from your design software. Also preview web pages in multiple 
browsers and operating systems with Adobe BrowserLab, another new CS Live online service.

Who uses Design Premium?
Graphic designers use Adobe Creative Suite 5 Design Premium to design content for a wide range 
of media, including print, web, interactive, and mobile devices.

Graphic designers are versatile professionals who apply their visual communication skills to a 
rapidly expanding variety of projects. Over the last 15 years, with the explosion of new forms of 
media from the Internet to the mobile phone, designers have faced tremendous pressure to 
continually learn new software and design techniques in order to produce work that stands out. 
Design Premium eases these challenges by providing a set of integrated tools for editing images, 
creating vector graphics, laying out print and web pages, crafting interactive designs, delivering 
content for mobile devices, and more.

Designers also face obstacles to preserving the integrity of their designs when they need to 
collaborate with technical colleagues such as developers. Communicating design intent to web, 
interactive, and application developers can be challenging—designers and developers speak 
different languages, and important nuances of designers’ vision can be lost in translation. Design 
Premium enables designers to express their vision directly using robust tools that draw on their 
existing skills and don’t require them to conquer code. Now designers can preserve the quality and 
integrity of their designs much further into the development process, handing off content without 
fear that the final result will be very different from what they envisioned. And for some types of 
projects, designers can even finish the work themselves.

Top new benefits in Design Premium

Explore new creative realms
Discover powerful new creative tools in Photoshop and Illustrator for crafting artwork that stands 
out in a wide range of media.

Realistic painting effects with Photoshop CS5 Extended
New tools enable you to paint in much the same way you would using real-world brushes and 
paints. With a new Mixer Brush tool, new bristle qualities, and new ways to blend colors, Photoshop 
CS5 Extended offers virtually endless possibilities for creating outstanding expressive effects, from 
enhancing photographic images in unusual ways to painting directly on a blank canvas.

Built to run on the latest 
operating systems

CS5 Design Premium takes advan-
tage of the power and performance 
of the latest Apple and Microsoft 
operating systems so you can work 
more quickly. And Photoshop CS5 
Extended is 64-bit native, which 
means even faster image-editing	
no matter which computer platform 
you use. (Design Premium set-up can 
also install a 32-bit version of Photo-
shop Extended, if you do not have a 
64-bit system.)

*CSLive online services are complimentary for a limited time. See the last page for details and limitations related to all Adobe online services.
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Use the Mixer Brush tool to fill a single brush with multiple paint 
colors, and then blend the paint colors with the underlying canvas 
colors to achieve results that rival traditional painting media. Or 
use a dry brush to blend a photograph’s colors and produce 
beautiful painterly results. Fine-tune your work by controlling 
how wet the canvas is, whether and how quickly the brush refills 
or cleans after each brush stroke, and the mixing proportions of 
paint color to canvas color. Photoshop CS5 also provides 
unprecedented control over brush qualities such as shape, length, 
thickness, stiffness, and angle. For example, you can specify a 
round, curved brush tip with long, fine, flexible bristles, or a flat, 
blunt brush tip with short, thick, stiff bristles. Use the Live Tip 
Preview to view a dynamic representation of the brush tip as you 
paint, and save your favorite brush tips for future use. 

Whether or not you’ve ever wielded a real-world paintbrush and 
mixed watercolors, acrylics, or oils, you’ll appreciate the promise 
of painting freely and naturally in Photoshop CS5.

With a variety of brush presets and settings for brush properties (above left 
and left), you can create an expressive image (below). The Bristle Brush 
Preview (right) provides dynamic feedback as you paint.

With the Mixer Brush tool, you can transform a photographic original into an expressive painting. (Original photograph, left; Mixer Brush layer, center; finished artwork, right.)
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Bristle Brushes can be used in a variety 
of ways. You can paint traditionally or 
you can brush along text shapes to 
create scrubby or soft-edged typo-
graphic effects. The Bristle logo (above) 
works equally well onscreen or on a 
billboard because it’s all purely vector.

Deliver crisp graphics for web, 
interactive, and mobile designs 
in Illustrator CS5

Create resolution-independent 
vector graphics that appear sharp	
in Dreamweaver, Flash Catalyst, 
Flash Professional, and Fireworks—
and on virtually any screen. With 
Illustrator CS5, you can create clean, 
crisp artwork that aligns accurately 
on pixels, letting you confidently take 
your artwork to PNG, JPG, GIF, or 
other raster formats. New controls 
streamline artwork creation for the 
web by automatically correcting 
drawn artwork to make sure it aligns 
to the pixel grid, eliminating blurred 
edges and “split pixel” lines. New 
options for text anti-aliasing provide 
precise control for the appearance 
of different fonts and type sizes, and 
each text frame can have its own 
anti-aliasing setting for optimal 
readability.

Fluid vector painting with Illustrator CS5
You don’t have to sacrifice the editability and scalability of vectors in order to enjoy the expressive-
ness of painting. Paint freely in Illustrator CS5 with the vector-based Bristle Brush to produce 
lifelike brush strokes. Create a new Bristle Brush, choosing from ten brush shapes ranging from 
round point to flat fan. Then use settings for size, bristle length, bristle density, bristle thickness, 
paint opacity, and stiffness to fashion exactly the brush you want. A preview window shows you 
how the Bristle Brush and its brush stroke will look. Each brush stroke creates a path that can be 
edited just as easily as if it had been created with the Pen or Pencil tool in Illustrator. Get the most 
out of the Bristle Brush using a tablet with a Wacom 6D Art pen, which responds automatically to 
pressure, bearing, tilt, and rotation.

With the Bristle Brush, you can enjoy the 
flexibility of vectors along with the feel and 
appearance of painting in natural media.

Choose from Bristle Brush presets that range from Round Point 
to Flat Fan, or customize your own Bristle Brush to achieve 
precisely the effect you want. 
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Easy 3D extrusions with Adobe Repoussé in Photoshop CS5 Extended
Repoussé is an ancient metalworking technique for embossing artwork on the surface of metals 
such as gold, silver, copper, tin, and bronze. Inspired by this technique, Photoshop Extended offers 
a powerful new Repoussé feature for creating eye-catching 3D artwork.

In Photoshop, start with a 2D element such as a text layer, selection, path, or layer mask, and then 
choose 3D > Repoussé. The 2D path is converted into a 3D object or “mesh” that you can extrude 
and then manipulate in a variety of ways. For example, you can control how far the object extrudes 
and whether it curves, bends, or twists. You can also apply a bevel to both the front and back 
surfaces of the extruded object and inflate a surface so that it appears as a smooth, curved surface. 
Additional settings let you apply materials such as brick, brushed steel, fabric, rusty metal, stucco, 
and wood. 3D-axis and rotation tools allow you to examine the 3D object from different angles as 
you work.

Use Adobe Repoussé to invent attention-grabbing 3D content for print or interactive content, 
animations, or immersive environments.

Convenient asset handling with 
Adobe Mini Bridge

Take advantage of a customizable 
panel in Photoshop CS5 Extended 
and InDesign CS5 to sort, filter, and 
drag files directly into your artwork 
or layout without ever leaving your 
design software.

With Adobe Repoussé, you can extrude, bevel, bend, shear, and twist any text layer, selection, path, or layer mask. Start with 
Repoussé shape presets, or experiment with settings for depth, scale, X and Y angle, and much more (below). Then apply 
lighting and materials (below right) to create effects never previously possible in Photoshop.



6Adobe Creative Suite 5 Design Premium What’s New

Express your ideas faster
CS5 Design Premium includes dozens of features designed to reduce the number of steps required 
to complete common tasks. Photoshop, Illustrator, InDesign, and Dreamweaver—the tools you use 
every day—all offer numerous enhancements to help you make fast work of your next project.

Truer Edge selection technology in Photoshop Extended
Photoshop CS5 Extended takes the time and frustration out of making precise image selections 
and masks, providing you a faster way to extract subjects from their backgrounds and create 
realistic composites. New intelligent selection technology offers better edge detection and faster, 
more accurate masking for complex subjects, such as hair. Automatic color decontamination helps 
you eliminate background color around the edges of a selection, resulting in more seamless 
compositions when placing extracted subjects on new backgrounds.

Experienced Photoshop users know that getting a perfect 
selection requires continually modifying your selection 
technique to respond to the varying characteristics of an 
edge—for example, one method for hair and another for 
the edge of a building. With new adaptive selection-edge 
modification controls in Photoshop CS5 Extended, you can 
produce highly accurate masks and selections faster and 
more simply than before. Smart Radius automatically 
matches the best selection approach with the subject’s 
changing edge characteristics, and extra view modes assist 
you in previewing the quality of your selections. The 
Refine Radius and Erase Refinements tools customize your 
masks and selections as you make them. These tools, in 
combination with the color decontamination settings, help 
eliminate any residual background color from around the 
edges of your selections.

All these enhancements, along with edge adjustments 
such as smoothness, feathering, and contrast, enable you 
to quickly produce selections and masks with incred-
ible accuracy and control.

More timesaving features in 
Photoshop CS5 Extended

See Adobe Photoshop CS5/
Photoshop CS5 Extended What’s 
New to learn more about these and 
other new productivity features:

•	Use Content-Aware Fill to remove 
any object or image detail and 
automatically fill in the space left 
behind with lighting, tone, and 
noise that match the surrounding 
area—so it looks as if the removed 
content never existed.

•	Use Puppet Warp to quickly and 
precisely reposition or warp any 
image element.

•	Enjoy productivity and creativity 
boosts thanks to dozens of features 
and enhancements requested by 
Photoshop users. Straighten images 
automatically, choose colors from 
an onscreen color picker, adjust the 
opacity of many layers simultane-
ously, and more.

Create accurate selections more easily with the 
Edge Detection controls in the updated Refine 
Edge dialog box.

Edge Detection uses adaptive selection 
technology to create selections along 
different edge types—such as a simple 
line, like the countours of a face, or a 
more complex edge, such as hair.

The Edge Detection and Decontaminate Colors features help you make highly precise selections of complex subjects quickly and easily, enabling faster, more accurate 
compositing. Original image (left). After refining the selection edge in Photoshop CS5 Extended (middle). Extracted subjects against new background (right).
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Beautiful strokes with Illustrator CS5
Whether you’re designing a complex infographic or a simple icon, finessing the details of strokes is 
an essential task. Illustrator CS5 includes several powerful features that make working with strokes 
more precise and flexible. 

•	 Variable-width strokes. Create strokes with variable widths that you 
can adjust quickly and smoothly at any point, symmetrically or along 
either side. Create complex, custom-width profiles that you can save 
and subsequently apply to any stroke.

•	 Dashed line control. Control alignment of dashes on a stroke. Now 
enjoy symmetrical dashes around corners and at the ends of open 
paths, with lengths adjusted automatically to fit.

•	 Precise arrowheads. Work
in a completely new way 
with arrowheads. Pick an 
arrowhead shape, and then 
control placement and 
scaling from within the Stroke 
panel. You can even choose 
whether to lock the tip or 
base of the arrowhead to 
the path endpoint.

Work interactively with stroke widths, using your cursor to adjust sides 
independently. Move and edit swells and constrictions freely along a path, 
and save stroke profiles for future use.

Choose to have dashed 
strokes symmetrically 

positioned around 
corners and show 

evenly at endpoints.Control arrowheads in the Stroke panel, 
and see how you can apply a saved 
width profile to create a tapered 
arrow body.
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•	 Stretch control for brushes. Define how art and pattern brushes scale along a path. Select areas 
of the brush graphic to stretch and those to keep in proportion. For example, you can stretch the 
center of a decorative banner while preserving the proportions of the scrolling ends.

•	 Brushes with corner control. Apply art and pattern brushes to a path and get clean results, even 
at tight bends or corners. Where strokes of different widths join, or form obtuse or acute angles, 
choose options to properly fill the points where the joins occur.

Simplified object selection and editing in InDesign
Aligning pictures in a grid, tweaking the white space between objects in a layout—finicky adjust-
ments like these take time. InDesign offers several elegant features for performing common 
repetitive, time-consuming layout tasks precisely and quickly. Whether you’re designing a docu-
ment that will be printed, viewed onscreen, or both, everything from aligning and distributing 
objects to adjusting corner effects is faster and easier in InDesign CS5.

•	 Multiple transformations with a single tool. Use the same tool to select, align, distribute, rotate, 
resize, reposition, crop, and scale frames and frame content. InDesign CS5 dynamically switches 
to the right tool for the job, so you don’t have to keep moving back and forth between the 
toolbox and your layout. The new Content Indicator lets you quickly reposition or rotate content 
within a frame, just by clicking and dragging. A real-time crop preview helps you position the 
content precisely where you want it.

•	 Gap tool. Adjust the white space between objects to dynamically reposition page items while 
maintaining spatial relationships. Shift the white space up or down, left or right, without cropping 
or resizing each object on the page. Persistent frame-fitting keeps the relationship between the 
object and its frame consistent even though the frame dimensions may change. You can even 
expand or contract the white space between adjacent objects, dynamically resizing or cropping 
the objects accordingly.

•	 Live corner effects. Drag the corners of a 
frame to dynamically change their radius and 
shape directly in the layout. Modify one corner 
at a time or all four corners simultaneously.

•	 Easy grid placement. Take the tedium out of 
creating a grid for placing images, as in a 
catalog or directory. Simply press arrow keys 
to add columns and rows for images or 
threaded text frames.

Click to make the corners active, and then drag the corner 
diamonds (inset) to new positions. On-object controls make it 
simple to dynamically change the look and feel of a frame as 
you design.

More timesaving features in 
Illustrator CS5

See Adobe Illustrator CS5 What’s New 
to learn more about these and other 
new features:

•	Perspective drawing. Draw shapes 
and scenes in accurate 1-, 2-, or 
3-point linear perspective.

•	Shape Builder tool. Intuitively 
combine, edit, and fill shapes 
directly on your artwork.

•	Drawing enhancements. Work 
faster with everyday tools. Join 
paths with a keystroke and draw 
behind or inside an object.

Use the Gap tool to adjust multiple 
images simultaneously while maintaining 
the spacing between the images. When 
Auto-Fit is enabled, InDesign honors 
object fitting settings (such as Center in 
Frame) to maintain the relationship 
between objects and their frames as you 
adjust the gap between objects. Simply 
drag the Gap tool to adjust the cropping 
of all the abutting images. Press 
Command or Control to resize a 
gap instead of moving it.

Instead of switching from the Selection 
tool to the Direct Selection tool to 
reposition content within a frame, simply 
click the Content Indicator in the center 
of the frame, and then drag.

Before: The image in the left column needs to be wider, while preserving the gutter 
space between it and the two images on the right.

After: With Auto-Fit checked, use the Gap tool to drag the gutter space, widening 
the image on the left while automatically adjusting the cropping of the other two.
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Multiple page sizes in a single InDesign CS5 document
In the past, working on a single project with multiple page sizes in InDesign meant juggling 
separate files and maintaining consistency among them. For example, in a magazine layout with 
foldouts or a marketing collateral project with brochures of different sizes, changing a paragraph 
style or color swatch required updating it in each file.

Now you can streamline design and production of these types of projects by including different 
page sizes in a single InDesign document. Use the new Page Selection tool to select and resize 
individual pages, applying resizing options in the Control panel. Easily share design assets by apply-
ing the same master page to different-sized layouts while controlling the placement of master 
elements in each individual layout. 

With multiple page sizes in a single document, you not only save time by not having to manage 
separate files, you reduce the risk of inconsistencies from forgetting to update them all.

More timesaving features in 
InDesign CS5

See Adobe InDesign CS5 What’s New 
to learn more about these and other 
new features:

•	Quickly format headlines, subheads, 
or any text to span multiple 
columns in a single text frame.   

•	Manage layers in simple and 
complex documents more easily 
using a new Layers panel.

•	Stay focused on design and 
production by exporting PDF 
documents in the background. 
InDesign takes advantage of	
64-bit multithreading, so you can 
export large files as you work on 
other projects.

Combining multiple page sizes in a single InDesign file makes it 
much easier to lay out documents with complex folds, such as 
this magazine with a cover flap. Multiple page sizes are shown 
in the Pages panel (left) and pasteboard (below).

Document-installed fonts 
in InDesign

The new document-installed fonts 
feature helps avoid the inconve-
nience of missing fonts during 
production and printing. When 
you package a document, InDesign 
includes fonts used in that document. 
When that document is opened on 
another system, InDesign looks for a 
document fonts folder, and automati-
cally installs those fonts for use only 
in that document. It then uninstalls 
them when the document is closed. 
This timesaving feature can help 
avoid costly design and print errors. 
Note that while InDesign takes the 
hassle out of installing the fonts 
required for printing a design project, 
the appropriate font licenses are still 
required for any party creating or 
printing the document.
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More efficient CSS-based design with Dreamweaver CS5
If you’re an aspiring or novice web designer who prefers designing pages to writing code, you’ll 
appreciate CSS Inspect. CSS Inspect lets you lay out web pages based on Cascading Style Sheets 
(CSS) more easily—without diving into code or using additional software. For designers who are 
new to web design or who want to deepen their knowledge of CSS, CSS Inspect makes it much 
easier to learn about and work with CSS-based web pages.

In the past, troubleshooting CSS-based page elements was not an intuitive process. First, you 
previewed the web page in a browser and used a browser plug-in or utility to search for the page 
element you wanted to modify. Then you viewed the element’s CSS rules and properties, noted the 
desired changes, and switched back to Dreamweaver to implement them.

Now you can accomplish this task seamlessly within Dreamweaver. CSS Inspect displays the CSS 
box model properties—including padding, border, and margin—so you can quickly locate and 
modify a CSS-based element. Simply select the element in Live View to view its corresponding CSS 
rules and properties in the CSS Styles panel. Make your edits directly in the panel or in the Code 
window and see the changes reflected immediately.

Click Inspect in the Dreamweaver Document toolbar or Control-click and choose Inspect from the context-sensitive menu to 
easily troubleshoot CSS-based page elements. Dreamweaver CS5 highlights box model properties with colors so you can 
visually inspect individual page elements.

Extend the reach of your designs to new media without writing code
When designers collaborate with developers to produce interactive content, they sometimes have 
to compromise their creative vision. With CS5 Design Premium, designers can work on interactive 
content and media-rich projects themselves using familiar tools, skills, and design processes—and 
without touching a line of code. Here are just two ways you can design and deliver your work in 
digital media using skills you already have:

•	 To craft interactive content that adds depth and impact to web pages, create artwork in 
Photoshop or Illustrator, and then use new Flash Catalyst to define interactions for elements 
such as buttons, sliders, and scrollbars. When you’re finished, export the interactive content as 
a SWF file. With Flash Catalyst, you can also design user interface elements for websites or 
applications and even create Adobe AIR® applications that run from the desktop.
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•	 To optimize a print layout for onscreen delivery, simply open the layout in InDesign and use new 
panels to add interactivity, animation, video, and/or sound.

Now you can take your designs in exciting new directions and maintain design control—without 
writing code.

Interactive content with Flash Catalyst CS5
New from Adobe and built specifically for designers, Flash Catalyst enables you to create 
interactive content without writing code. With Flash Catalyst, you can take advantage of the 
expressiveness of Flash technology and the ubiquity of Flash Player to deliver compelling 
interactivity, video, and audio to computers around the world.

Transform artwork created in Photoshop, Illustrator, or Fireworks into high-quality interactive 
content that can liven up your web pages or make complex information engaging and easier to 
understand. Design simple projects, such as an interactive portfolio site or product brochure, that 
you can complete yourself in SWF format. Or tackle more complex projects such as a user interface 
for a web application built in collaboration with a developer. While you design visually in the 
foreground, Flash Catalyst generates Adobe Flex® code in the background.

Begin by importing a design comp created in Photoshop, Illustrator, or Fireworks into your Flash 
Catalyst project. Use easy-to-understand menu commands to convert individual elements into 
functional interactive components such as buttons, sliders, and scrollbars. When you’re finished 
polishing your interactive content, you can add it to web pages, embed it in a PDF file, or run it as a 
self-contained Adobe AIR application directly on the desktop.

Venture into the exciting realm of interactive design without ever writing or editing a line of code.

Roundtrip editing of graphics 
between Flash Catalyst CS5 and 
Illustrator CS5

Use Illustrator CS5 to develop 
interaction design ideas, craft screen 
layouts, and create graphics for use 
as user interface components. Then 
open your Illustrator artwork in Flash 
Catalyst and add actions and interac-
tivity. After you’ve added interactivity, 
you can still make edits and design 
changes directly within Illustrator 
(see example below).

Roundtrip editing of graphics between Flash Catalyst CS5 and Illustrator CS5 makes it easier to fine-tune elements of your 
interactive design. In Flash Catalyst CS5, select an element, and then choose Modify > Edit In Adobe Illustrator CS5 (above 
left). Flash copies the selected element (here, the orange arrow on the black background) and captures a screenshot of the 
entire page. Illustrator then opens a new document and places the screenshot, at 20% opacity, on a locked layer—along with 
all four button states (shown below). When you save the Illustrator file, the Flash Catalyst file is automatically updated. 

Note that the graphic from Flash 
Catalyst is being edited in Illustrator.
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Dynamic digital documents with InDesign CS5
Catching and keeping people’s interest online gets more challenging every day. Now you can add 
attention-grabbing interactivity, animation, video, and sound to your digital documents and 
presentations—and you can do this all in InDesign without learning new software.

InDesign CS5 includes support for FLV video and MP3 audio files, as well as dozens of motion 
presets that make it easy to create animations. Export a document or presentation from InDesign 
to SWF format for playback in Adobe Flash Player or a web browser. Or export a document as an 
interactive PDF file, complete with video and sound. Five new panels provide intuitive controls that 
enable you to create a wealth of dazzling effects.

•	 Animation panel. Animate objects in InDesign using the same motion presets included in Flash 
Professional CS5. Simply select an object, choose a triggering event such as on page load, click, 
or rollover, and then select from presets ranging from fade in and fly out to bounce, dance, gallop, 
and pulse. Easily specify the duration, speed, rotation, scale, and opacity of animations. Quickly 
edit an animation’s motion path using the Pen tool, and convert a line drawing—even one you 
import from Illustrator—into a custom motion path with the click of a button.

•	 Object States panel. Create multi-state objects that have different appearances depending on a 
viewer’s actions. An object state can be an image, text frame, or any other object or group to be 
displayed when the viewer clicks or rolls over an interactive button in a SWF or interactive PDF file.

•	 Timing panel. Control when objects such as bullet points in a presentation or images on a page 
animate. Animation can occur when the page loads, or only after you click the page. Loop the 
animation or play it a specific number of times. Link objects to ani-
mate simultaneously, with the same or different durations.

•	 Preview panel. Check animations, buttons, and other interactive 
elements directly in InDesign. Preview a selection, a page or 
spread, or the entire document before you export it to SWF format.

Drag and drop states to control the 
sequence in which they appear.

Open the Preview panel (above) to view, refine, and troubleshoot your animation before exporting a final SWF file. (Note the animated clouds above the skyline.) 
Use the Timing panel (above right) to control when animations begin to play and how many times they repeat.

Enhanced eBook document design 
with InDesign CS5

As eBook technology continues to 
evolve, designers are looking for 
ways to deliver high-quality content 
in the latest formats for the latest 
devices. Create compelling eBooks 
with enhanced support for the EPUB 
file format. Author eBooks that can 
be read on a variety of devices such 
as the Apple iPad, Sony Reader, 
Barnes & Noble nook, mobile phones, 
or personal computers using Micro-
soft® Windows® or Mac OS. Include 
interactivity, animation, sound, and 
video to bring eBooks to life when 
read on a personal computer using 
Adobe Digital Editions, a desktop 
reading application. Enhanced export 
features include the ability to control 
content reading order based on docu-
ment structure, support for prebuilt 
CSS to provide consistent styling, 
support for chapter breaks, improved 
table formatting, and font subsetting.

In addition to controlling duration, speed, and other animation 
settings, you can preview motion presets in the Animation 
panel (left). When you select a preset, it’s applied to the 
butterfly so you can see the effect.
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•	 Media panel. Once you’ve placed a video, you 
can scrub through it without leaving InDesign. 
Select a frame to represent the video in your 
InDesign document before the video plays, and 
even create navigation points that determine 
which parts of the video play when you click a 
button or otherwise trigger an action.

Superior text layout and typography in 
Flash Professional CS5
Now your typography can look as good onscreen 
as in print with a new text engine in Flash 
Professional that preserves the type you create in 
InDesign. When you hand off InDesign CS5 pages 
to Flash Professional CS5, the text flows into threaded text frames, making it easy to do last-minute 
edits. Also enjoy advanced typographic control directly within Flash Professional, including:

•	 Advanced text styling. Finesse the details with controls for kerning, ligatures, tracking, leading, 
superscript, subscript, discretionary hyphens, margins, hypertext, baseline shift, typographic case, 
oldstyle/lining figures, and proportional/tabular figures. CSS anti-aliasing is also supported.

•	 Advanced text-layout control. Place text precisely using controls for threaded text blocks, 
multiple columns, text wrap, and tab stops.

Improved InDesign export to 
Flash Professional

CS4 Design Premium introduced	
the ability to export documents 
to the XFL format and open them 
in Flash CS4 Professional while 
maintaining the visual fidelity of the 
original InDesign layout. CS5 Design 
Premium makes this process even 
better—now interactive buttons, 
multi-state objects, and placed video 
and audio files from the InDesign 
layout are carried over into Flash 
Professional. Objects animated 
with motion presets in InDesign are 
added as motion objects to the Flash 
Professional timeline. The original 
layer structure of the InDesign 
document is recreated in the Flash 
Professional timeline, making it 
easier for the Flash developer to 
understand how a page was created.

Use the Media panel (left) to 
scrub through a movie and to 
select a frame to represent it 
on the page (below).

Designers who love fine typography will 
be thrilled by extensive type controls in 
Flash Professional CS5.
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Simplified mobile-content design with Fireworks CS5 and Device Central CS5
Easily experiment with designing for mobile devices. Integration between Fireworks and Device 
Central makes it easy to set up a Fireworks project and preview it in Device Central. In Device 
Central, choose File > New Document In Fireworks, select a target device, and then click Create. 
Fireworks then creates a new project with the correct pixel dimensions of the target device’s 
display. Use the visual prototyping tools in Fireworks to craft your mobile content, and then choose 
File > Preview In Device Central to emulate your content using the updated online library of device 
profiles. When you’ve perfected your prototype, hand it off for development in Flash Professional 
or Dreamweaver.

Maximize your design time by streamlining critical non-design tasks
CS5 Design Premium integrates with Adobe CS Live online services* to help you bring efficiencies 
to design and production activities.

Accelerated reviews through integration with Adobe CS Review
Enjoy faster, more efficient creative reviews with CS Review, a new Adobe CS Live online service* 
that integrates with components of CS5 Design Premium. Initiate shared reviews with just a few 
clicks from within Photoshop, Illustrator, or InDesign—simply click Access CS Live in the 
Application bar to open the CS Review panel. Then create a new review, add your layout or 
artwork, and invite colleagues or clients to view it online. They receive an email invitation with a 
link—one click and they see the document displayed in their web browser.

With commenting tools so easy to use there’s practically no learning curve, your reviewers can give 
overall feedback or comment on a specific region or text selection. Their comments appear in the 
CS Review panel, and everyone can view and reply to each other’s comments. Clicking a comment 
takes you to the specific element the comment refers to, so you can easily match each comment to 
the right element in your layout or artwork. 

Flash animation

Flash CS4 Professional made 
animation easier and more intuitive 
for designers who don’t write code. 
Flash Professional CS5 goes even 
further by providing significantly 
improved text handling, brushes for 
easily drawing shapes and adding 
advanced animation effects, and a 
library of ready-to-use code snippets 
for controlling components such as 
actions, animation, audio, and video.

Integration between Fireworks CS5 
and Device Central CS5 means you 
can begin a Fireworks project using 

the exact specifications of a target 
mobile device. Then you can preview 
your design in Device Central before 

handing it off to a developer.

*CSLive online services are complimentary for a limited time. See the last page for details and limitations related to all Adobe online services.
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With simple sharing, easy access to reviews, and centralized comments, CS Review* can help speed 
up the review process so you can finish your project on time and within budget. 

*CS Review, BrowserLab, and other CS Live online services are complimentary for a limited time. See the last page for details and	
limitations related to all Adobe online services.

Web-page preview with Adobe BrowserLab*
If you’ve done even a little web design, you know how challenging it can be to predict how a web 
page will appear in different browsers and operating systems. Until now, the best way to preview 
web content required buying costly hardware, installing multiple browsers, and maintaining testing 
labs. In addition, opening and comparing pages in multiple browsers on multiple machines is 
tedious and time-consuming.

To initiate a shared review, simply click Access CS Live on the Application bar in 
InDesign, Photoshop, or Illustrator, and then choose Create New Review.

Reviewers can see the review within 
their browser (above), and add com-
ments using simple annotation tools. 
Those comments appear in the CS 
Review panel in InDesign (right). 
Thumbnails provide context for the 
feedback, making it easier to find and 
address comments.†

†When the CS Review online service goes live, certain aspects of its web client user interface will differ from what is shown here.
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Another new CS Live online service*, Adobe BrowserLab, is an easier, faster solution for previewing 
web pages on leading browsers and operating systems—on demand. Whether you’re creating web 
pages yourself or previewing pages that you’ve designed and handed off to a developer for 
production, BrowserLab enables you to ensure that your work will appear as you intend.

BrowserLab works by taking screen shots of your web pages in different browsers, and then 
displaying them in the BrowserLab application window. You can preview a page in a single browser 
or compare the page in two browsers side by side. You can also compare screen shots in onion-
skin view—with one image superimposed over another—and control the relative transparency of 
the two images. Built-in rules and guides enable you to make pixel-perfect comparisons between 
images. Use the service from your web browser to test pages that you’ve posted to a server, or take 
advantage of integration between BrowserLab and Dreamweaver to test your pages directly from 
within Dreamweaver without publishing them to a server. Simply open a page in Dreamweaver, 
choose File > Preview In Browser > Adobe Browser Lab, sign in, and choose the browsers in which 
you want to preview the page. Create and configure sets of browsers you want to test. And because 
BrowserLab is an online service, you can get your results in real time, from virtually any computer 
connected to the web.

Adobe BrowserLab is a fast, flexible, and convenient way to make sure your web designs look 
exactly the way you intend them to look, no matter what browser, computer, and operating system 
is used to view them.

Still using Adobe Creative Suite 3 Design Premium?
If you’re considering upgrading to CS5 Design Premium, remember that you’ll benefit from all the 
new features described above, as well as all the new features in CS4 Design Premium. They include:

Features to help you work faster

•	 Content-Aware Scaling in Photoshop Extended. Use the revolutionary Content-Aware Scaling 
feature to automatically recompose an image as you resize it, smartly preserving vital areas as 
the image adapts to the new dimensions. Get the perfect image in one step without time-inten-
sive cropping and retouching.

•	 Smoother panning and zooming and fluid canvas rotation in Photoshop Extended. Navigate 
gracefully to any area of an image with new, ultra-smooth zooming and panning. Just click to 
smoothly turn your canvas for distortion-free viewing at any angle—no more tilting your head 
while painting and drawing.

Meet live over the web and share 
your screen with anyone

Adobe ConnectNow is a personal 
web conferencing solution that 
makes it easy to quickly share ideas 
and discuss details of a project with 
others—all online. ConnectNow is 
part of Acrobat.com, one of the CS 
Live online services*, and is acces-
sible from your web browser. With 
ConnectNow, you can:

•	Share your screen. Simply choose 
File > Share My Screen from your 
design software to initiate a web 
conferencing session and show 
participants artwork or a layout on 
your computer.

•	Interact with others. Use screen 
sharing, chat, notes, audio, and 
video to conduct meetings online 
that can be as interactive and 
productive as in-person meetings.

•	Get instant access from 
anywhere. Use the free Adobe 
Flash Player runtime to join the 
meeting from virtually any platform 
and browser.

•	Be productive right away. With 
instant access and an elegant user 
interface that is remarkably easy to 
use, you can start being productive 
right away. No training necessary.

Also part of Acrobat.com:

•	Online Workspaces. Virtually 
eliminate the need to email files 
between team members by setting 
up an online Workspace so that you 
can easily share a set of files with an 
extended team. 

•	Adobe Buzzword. Use Adobe 
Buzzword, an online word 
processor, to write and collaborate 
on reports, proposals, and anything 
else you need to access online or 
work on with others.

•	Acrobat.com Presentations. 
Collaborate with colleagues to create 
presentations. Your slides are always 
available online, so you can make 
last-minute tweaks and present the 
content from wherever you are.

•	Acrobat.com Tables. Work with 
others on information typically 
shared in spreadsheets or simple 
databases. Multiple people can 
update data at any time, so you 
have a living document for 
maximum collaboration.

*CSLive online services are complimentary for a limited time. See the last page for details and limitations related to all Adobe online services.

With BrowserLab, a new CS Live online service*, you can easily preview web pages on leading browsers and operating 
systems, ensuring that your designs are displayed consistently wherever they are viewed. Compare different versions using 
2-up view (shown above) or onion-skin view. (Note the differences in how the green Columns menu is displayed.)
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System requirements
Windows
•	 Intel® Pentium® 4 or AMD Athlon® 64 

processor

•	Microsoft® Windows® XP with Service Pack 
3; Windows Vista® Home Premium, Busi-
ness, Ultimate, or Enterprise with Service 
Pack 1 (Service Pack 2 recommended); or 
Windows 7  

•	1GB of RAM or more recommended

•	9.3GB of available hard-disk space for 
installation; additional free space required 
during installation (cannot install on 
removable flash-based storage devices)

•	1280x800 display with qualified 
hardware-accelerated OpenGL graphics 
card, 16-bit color, and 256MB of VRAM

•	Some GPU-accelerated features require 
graphics support for Shader Model 3.0 
and OpenGL 2.0 

•	Some features in Adobe Bridge rely on a 
DirectX 9–capable graphics card with at 
least 64MB of VRAM

•	CD-ROM drive compatible with dual-layer 
DVDs

•	 Java™ Runtime Environment 1.5 (32 bit)	
or 1.6

•	QuickTime 7.6.2 software required for 
multimedia features

•	Adobe Flash® Player 10 software required 
to export SWF files

•	Broadband Internet connection required 
for online services*

Mac OS
•	Multicore Intel® processor

•	Mac OS X v10.5.7 or v10.6

•	1GB of RAM or more recommended

•	10.3GB of available hard-disk space for 
installation; additional free space required 
during installation (cannot install on a 
volume that uses a case-sensitive file 
system or on removable flash-based	
storage devices)

•	1280x800 display with qualified 
hardware-accelerated OpenGL graphics 
card, 16-bit color, and 256MB of VRAM

•	Some GPU-accelerated features require 
graphics support for Shader Model 3.0 
and OpenGL 2.0 

•	CD-ROM drive compatible with dual-layer 
DVDs

•	 Java™ Runtime Environment 1.5 or 1.6   

•	QuickTime 7.6.2 software required for 
multimedia features

•	Adobe Flash® Player 10 software required 
to export SWF files

•	Broadband Internet connection required 
for online services* 

For updates to system requirements, visit www.adobe.
com/go/designpremium_systemreqs.

•	 Multiple artboards in Illustrator. Create files containing up to 100 artboards of varying sizes
and display them any way you want—overlapping, side by side, or stacked. Save, export, and print 
artboards independently or together. Save a selected range or all artboards as a multipage PDF file.

•	 Blob Brush tool in Illustrator. Sketch with a brush that generates a single clean vector shape, 
even when strokes overlap. Draw naturally, using the Blob Brush tool together with the Eraser 
and Smooth tools.

•	 Customizable Links panel in InDesign. Find, sort, and manage all of your document’s placed 
files in the customizable Links panel. View attributes that are most critical to your workflow, such 
as scale, rotation, and resolution.

•	 Live Preflight in InDesign. Preflight while you design. Continuous preflighting alerts you to 
potential production problems in real time so you can quickly navigate to a problem, fix it directly 
in layout, and keep working.

•	 PDF Portfolios in Acrobat 9 Pro. Assemble layouts, drawings, images, video, audio, and other 
files into a single dynamic PDF Portfolio. Customize the PDF Portfolio interface using profession-
ally designed templates and interactive navigation.

•	 Enhanced preflighting in Acrobat 9 Pro. Control costs and reduce errors more effectively. 
Provide preflighting instructions and custom PDF export presets. Automatically validate files and 
easily fix issues from faulty hairlines to transparency handling, and more.

Features to help you work more easily in more media

•	 Fireworks included in Design Premium. Rapidly prototype websites, application interfaces, and 
other interactive designs. Design and prototype complete web pages and then export them as 
CSS-standard HTML, complete with external style sheets.

•	 Export InDesign documents and open in Flash Professional. Export InDesign documents to
the XFL format and open them in Flash Professional with the visual fidelity of your original 
layout maintained.

•	 Easy-to-do animation in Flash Professional. With object-based animation in Flash Professional, 
create simple but engaging animations in as few as two steps.

•	 Photoshop Smart Objects in Dreamweaver. Insert any Photoshop PSD document in
Dreamweaver to create an image Smart Object tightly linked to the source file. Make changes 
to the source image, and then update your image in Dreamweaver without opening Photoshop.

About Adobe Creative Suite 5 Design Standard
For design and production professionals who are focused on print publishing and do not need web, 
interactive, and mobile design capabilities or advanced image-editing tools, Adobe offers Adobe 
Creative Suite 5 Design Standard software. Design Standard combines full new versions of InDesign 
CS5, Illustrator CS5, Photoshop CS5, and Acrobat 9 Pro with Adobe Bridge CS5, Adobe Device 
Central CS5, and integration with CS Live online services*.

About Adobe Systems Incorporated
Adobe is the world’s leading provider of software solutions to create, manage, and deliver high-
impact, reliable print and digital content. For more information, visit www.adobe.com.



Adobe Flash authoring tools in Adobe Creative Suite 5 Design Premium
With Creative Suite 5, Adobe delivers a variety of tools with the capability to author interactive content for the Adobe Flash Platform.  
Each project you work on is unique, presenting various requirements and specifications regarding design, development, and deploy-
ment. This comparison chart is a quick reference that will help you choose the best tool or tools for what you want to accomplish.

Flash Professional Flash Catalyst InDesign

Typical projects Rich content, interactive video 
content, advertising, games

User interfaces, rich Internet 
applications, microsites, prototypes, 
widgets

Documents, presentations, and 
portfolios in both print and digital 
formats

Product description An authoring tool that enables you to 
create immersive experiences that 
can include video content

An interaction design tool that 
enables you to transform artwork into 
functional interfaces and interactive 
content

A page layout tool that enables you to 
design high-quality documents, 
interactive presentations, and 
portfolios

Project approach Free-form design Structured interaction design Free-form design

Project organization Timeline and frames Pages and states Pages and layers

Motion capabilities Advanced vector animation Transitions, basic movement Transitions, motion presets, motion 
along paths

Video playback Encoding & advanced playback 
controls

Basic video playback controls Basic playback controls

Extensibility ActionScript coding or components Flash Catalyst components or export 
to Flash Builder to add more 
functionality

Only if content is opened in Flash 
Professional

Coding knowledge 
required

Some ActionScript coding None None

Playback support Flash Player, AIR, Flash Lite, iPhone* Flash Player 10, AIR Flash Player 10

* Packager for iPhone preview, included with Flash Professional CS5, compiles ActionScript bytecode into native iPhone application code.  
iPhone applications are distributed as iPhone application installer (IPA) files, via the iTunes store.
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